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on Solaris

These release notes are for Campus Manager 5.0, which is a part of the CiscoWorks family of products, 
running on a Solaris platform.
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New Features
This section describes the new features and enhancements available in Campus Manager 5.0. An 
overview of the new features and enhancements is provided here. For complete details on them, see User 
Guide for Campus Manager 5.0.

This section explains:

• Dynamic User Tracking

• User Tracking History Reports

• Enhanced User Tracking to Discover End hosts on Trunk Ports

• Enhanced Switch Port Usage Reports

• Enhancements to DNS Resolution
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New Features
• Enhanced Discrepancy Reports

• New Workflow for VLAN Management Tasks

• Handling Duplicate MAC Address

• Enhanced Topology Services

• Critical Device Poller

• N-Hop View Portlet

• Improved Device Management

• Improved Integration with Other LMS Applications

Dynamic User Tracking

User Tracking Dynamic Updates track changes of the end hosts and users in the network with minimal 
time delay. In addition to polling the network at regular intervals, Campus Manager tracks the changes 
in the network whenever they occur. 

Dynamic updates are asynchronous updates that are based on SNMP MAC notification traps.When a 
host is connected to the network, an SNMP MAC notification trap is immediately sent from the switch 
to the Campus Manager server. 

These traps enable Campus Manager to provide accurate information about the VLAN, port etc. to which 
the end host is connected. Traps are generated when a host is connected to the network, disconnected 
from the network or when it moves between VLANs in the network.

Dynamic updates also report immediately when a user connects to the network, with the help of UTLite 
scripts. For example, if you have an user named Joe, you can accurately track which switch port he is 
connected to in real-time.

Thus Dynamic updates provide real-time tracking where there is high user mobility or frequent changes 
to VLAN information.

User Tracking Major Acquisition tracks a maximum of 250,000 entries (End hosts and IP phones). 
2,500,000 end host history records can be maintained in the Campus Manager database. 

Note Campus Manager Data Collection discovers and tracks a maximum of 150,000 Switch Ports.

User Tracking History Reports

History Report provides details of the end hosts that were connected to or disconnected from a specific 
switch port for a period of time.

You can generate History reports based on the IP address and the MAC Address of endhosts, users 
logged into the endhosts and the devices to which endhosts are connected. 

You can generate History reports for Switchport utilization to view the duration for which, the ports in 
a switch have been used. 

You can generate History reports for Switch ports. This report contains details of the host connected to 
the port, the time at which the host was connected and disconnected, and the VLAN associated to the 
port.

Enhanced User Tracking to Discover End hosts on Trunk Ports

Campus Manager User Tracking is now enhanced to discover end hosts connected to Trunk ports.

From the available non-link trunk ports, select the ports for end host discovery. End hosts connected to 
the selected non-link trunk ports will get discovered during next UT Major Acquisition cycle.
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New Features
Enhanced Switch Port Usage Reports

Switch Port usage reports are enhanced to show the Port Utilization percentage and unused up/down 
ports for specified period. These reports are:

• Switch Port Utilization Report:

Switch Port percentage Utilization report lists the switches that crossed utilization threshold limits 
along with the value of percentage port utilization. This report enables you to do capacity planning 
for network growth.

You can schedule these reports as jobs, to get the list of switches that cross the threshold limits at 
regular intervals

• Reclaim Unused Up Report: 

You can generate reports for ports that have been in Up state (Administratively Up and Operationally 
Down) for a specified interval of time.

• Reclaim Unused Down Report:

You can generate reports for ports that have been in Down state (Administratively Down and 
Operationally Down) for a specified interval of time.

• Report on Recently Down ports:

You can generate reports for Recently Down ports.

Access ports that were connected to an end host in the last UT Major Acquisition cycle, but were 
found unconnected in the current Data Collection cycle are listed as Recently Down ports.

• Switch Port Summary Report:

This report gives the number of Connected, Free, and Free Down ports in each switch. The ports are 
classified as follows: 

– Ports that are administratively up but are not connected to endhost are Free ports.

– Ports that are administratively down and are not connected to endhost are Free Down ports.

This report also provides the sum total of Connected, Free and Free Down ports in each switch. 

Enhancements to DNS Resolution

Enhancements have been made in DNS resolution by implementing the time-outs and threading for 
reverse lookups. This results in quick time-outs for the non-existent DNS entries, and reduced time for 
DNS resolution for all hosts.

If your DNS server supports multiple threads, you can configure User Tracking to use multiple threads, 
up to a maximum of 12 threads, so that DNS resolution time is faster.

Enhanced Discrepancy Reports

Discrepancies are now classified as Network Discrepancies and Best Practice Deviations.

• Network Discrepancies — Those that have a severe impact on the network connectivity.

• Best Practices Deviations — Best practices that has been recommended by Cisco but not 
implemented in the network.

Network Discrepancies/Best Practices Deviations reports have been enhanced to enable you to fix 
the issue from the UI (currently not available for all types of discrepancies).

The Acknowledge/ Unacknowledged feature allows you to view only the required Discrepancy/Best 
Practices Deviation.

• Discrepancies and User Tracking
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New Features
User Tracking end host reports now show the Discrepancies and Best Practices Deviations 
associated with each end host port. It also provides a link to launch these reports from User Tracking 
end host report. 

New Workflow for VLAN Management Tasks

New wizard based User Interface (UI) workflow with enhanced Device selector search facility, that helps 
you to:

• Create and delete VLANs 

• Create, delete PVLAN and configure Promiscuous ports

• Create and modify Trunk attributes

• Assign ports to VLANs

You can do the following with the improved workflow:

• Create and delete VLANs on multiple devices irrespective of VTP domain 

• Assign access link ports to a desired VLAN

• Move ports to temporary VLAN while deleting the associated VLAN

• Configure Trunks and modify Trunk attributes. 

Creating Trunks through the new UI gives a better user experience than configuring through Topology 
maps, where you needed to wait for the map to load and then do the configuration.

Handling Duplicate MAC Address

You can specify the list of Switches, Switchports, Subnets and VLANs for which Duplicate MAC 
addresses can either be included or excluded. 

Enhanced Topology Services

The following are the enhancements in Topology Services:

• Java Web Start Support

Topology Services and Path Analysis will now be launched in Web Start.

This eliminates conflicts between multiple Java Plug-ins on the client machine and the applications 
are loaded faster.

• Utilization Statistics in Topology Maps

Topology Services categorizes links in your network according to the percentage of bandwidth 
utilization. It displays the links using different colors in Topology Maps.

You can customize the percentage of utilization and the color of the links, so that Topology Map 
displays the links accordingly.

Topology Services computes bandwidth utilization only for Ethernet links and uses Remote 
Monitoring (RMON) to compute bandwidth utilization.

• Switch Cluster Support

Campus Manager is now enhanced to discover Commander and member devices of a Switch Cluster. 
You can create and delete VLANs in these switches. 

• PoE Capable Devices

Campus Manager Topology Services now provides a filter to view PoE capable devices in present 
in your network. 
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Product Documentation
Critical Device Poller

This is a new feature to frequently poll a critical set of devices in your network. The default time at which 
the critical poller runs is five minutes but it allows you to set the timings. Devices can be added to the 
Critical Device Poller from Topology views and N-Hop view portlet. 

N-Hop View Portlet

N-Hop View portlet is a HTML based light weight feature and is available as part of CiscoWorks Portal. 
This is much faster than the regular Campus Manger Topology services.

When you enter the root device and number of hops, the portlet displays a N-hop view from the specified 
root device. 

The portlet refreshes the topology map every five minutes and the data is fetched from the last polling 
cycle of the critical device poller. You can monitor critical devices using this feature, since the changes 
are reflected immediately in the portlet. This feature should be used to view a limited set of devices.

Improved Device Management

You can manually add devices from DCR to Campus Manager or delete devices that are being managed 
in Campus. This Manual mode of adding or deleting devices to and from Campus can work together with 
the Data Collection filter policies set in Auto mode. 

Improved Integration with Other LMS Applications

You can launch the following LMS applications from CM:

• RME — NetConfig, Software Management

• DFM — Fault History Report, Real-time fault Display (not device specific)

• CiscoWorks Assistant — Device Troubleshooting Report

RME CWCLI feature is used by Campus Manager for:

• Trap configurations on switches.

• Fixing discrepancies in the network.

Product Documentation

Note We sometimes update the printed and electronic documentation after original publication. Therefore, 
you should also review the documentation on Cisco.com for any updates.

Table 1 describes the product documentation that is available.

Table 1 Product Documentation

Document Title Available Formats

User Guide for Campus 
Manager 5.0

• PDF on the LMS Documentation CD-ROM.

• On Cisco.com at:

http://cisco.com/en/US/products/sw/cscowork/ps563/produc
ts_user_guide_list.html
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Related Documentation
Related Documentation

Note We sometimes update the printed and electronic documentation after original publication. Therefore, 
you should also review the documentation on Cisco.com for any updates.

Table 2 describes the additional documentation that is available

Supported Devices Table for 
Campus Manager 5.0

On Cisco.com at this URL:
http://cisco.com/en/US/products/sw/cscowork/ps563/
products_device_support_tables_list.html

Context-sensitive Online help • Select an option from the navigation tree, then click Help.

• Click the Help button in the dialog box.

Table 1 Product Documentation (continued)

Document Title Available Formats

Table 2 Related Documentation

Document Title Available Formats

Release Notes for CiscoWorks 
Common Services 3.1 

• PDF on the LMS Documentation CD-ROM.

• On Cisco.com at:
http://cisco.com/en/US/products/sw/cscowork/ps3996/prod_
release_notes_list.html

Installing and Getting Started with 
LAN Management Solution 3.0

• Printed document that was included with the product.

• PDF on the LMS Documentation CD-ROM.

• On Cisco.com:

http://www.cisco.com/en/US/products/sw/cscowork/ps2425/
prod_installation_guides_list.html

User Guide for CiscoWorks 
Common Services 3.1

• PDF on the LMS Documentation CD-ROM.

• On Cisco.com at:
http://cisco.com/en/US/products/sw/cscowork/ps3996/produ
cts_user_guide_list.html

Data Migration Guide for LAN 
Management Solution 3.0 (for 
Maintenance Customers)

• PDF on the LMS Documentation CD-ROM.

• On Cisco.com:

http://www.cisco.com/en/US/products/sw/cscowork/ps2425/
prod_installation_guides_list.html
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Additional Information Online
Additional Information Online
The following product specific information is available online:

Service Packs (SP) contain updated files necessary for the latest device support and fixes to known 
problems that are not available in Campus Manager 5.0. If you are a registered user, you can download 
SP for Campus Manager from:

http://www.cisco.com/cgi-bin/tablebuild.pl/cw2000-campus

Support Information
Campus Manager 5.0 supports only US-English and Japanese versions of Solaris Operating Systems. It 
does not support any other language version. Set the default locale to US-English for US-English version 
and Japanese for Japanese version.

Caveats
Note the following:

• Campus Manager requires a DNS server to function properly. Many commands operate erratically 
or not at all, if there is no DNS server on the network.

• You cannot run Campus Manager from a browser invoked from an X-Window System since this is 
not supported. Install a browser on the client from which you wish to connect.

• You can upgrade your operating system (OS) either before or after you upgrade Campus Manager. 
However, if you upgrade the OS after upgrading Campus Manager, you will not receive any 
OS-related patch warnings or service pack-related warnings.

• Verify that the latest version of all required OS patches, service packs, and third-party device drivers 
are installed before proceeding with an OS upgrade.

• Do not export an entire topology map to Visio. Instead, select and export particular devices or a 
segment of the network and export it.

Known Problems
This section describes the known problems in this release:

• General Known Problems, page 8

• Browser Known Problems, page 13

• Path Analysis Known Problems, page 13

• User Tracking Known Problems, page 18

• Topology Services Known Problems, page 24

• ANI Server Known Problems, page 34
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Known Problems
• VLAN Configuration Known Problems, page 39

• Spanning Tree Protocol Known Problems, page 41

Note To obtain more information about known problems, access the Cisco Software Bug Toolkit at 
http://www.cisco.com/cgi-bin/Support/Bugtool/home.pl
(You will be prompted to log into Cisco.com)

General Known Problems
The table below lists the known problems that are not specific to any module in Campus Manager.

Table 3 General Known Problems

Bug ID Summary Explanation

CSCse39112 Rules created for Groups in 
Campus Manager do not work 
properly.

In the Campus Manager 4.0.4 Rules creation 
screen, DiscoveryStatus operator is changed from 
"=" to "equals". 

If you have created a rule with "=" operator in the 
earlier versions of Campus Manager and upgrade 
it to Campus Manager 4.0.4 or above, the rule will 
not work.

Workaround:

1. Open the rule created in the older version of 
Campus.

2. Change  "=" to "equals" 

3. Save the rule.

CSCsi44992 Switch Port Reports for Unused 
Up and Unused Down ports are 
migrated from LMS 2.6 to LMS 
3.0.

Switch Port Reports for Unused Up and Unused 
Down ports are available in LMS 2.6 but not in 
LMS 3.0.

These reports are migrated, when you do local or 
remote data migration from LMS 2.6 to LMS 3.0.

If you have scheduled jobs for these reports, they 
do not run in LMS 3.0.

Workaround:

After upgrading to LMS 3.0, delete the scheduled 
jobs for Switch Port Reports on Unused Up/ 
Unused Down ports.
8
Release Notes for Campus Manager 5.0 on Solaris

OL-12202-01

http://www.cisco.com/cgi-bin/Support/Bugtool/home.pl


 

Known Problems
CSCsb86066 Campus Manager does not work 
properly when NAT or firewall 
are configured.

The following problems occur if Campus Manager 
is installed in a server with NAT or firewall:

• You cannot launch some of the Campus 
Manager User Interfaces.

• You cannot generate Discrepancies report and 
Best Practices Deviation report

In the above cases, following error message is 
displayed:

Error in loading properties from the server

• You cannot launch:

– Topology Services

– Path Analysis 

In the above case, the following message appears:

Cant connect to ANI Sever

Workaround:

For Campus Manager working inside a Firewall:

Enable the ports supported by Common Services, 
Topology and Path Analysis work in a firewall 
setup. 

For details on these ports, see 
http://www.cisco.com/en/US/products/sw/cscowo
rk/ps2425/prod_installation_guides_list.html

There is no workaround for the above issues, if 
Campus Manager is installed in a server with NAT.

CSCsj16376 Purging in Campus jobs does not 
work properly.

When you delete jobs older than a day, jobs that 
were completed on the current day are also 
deleted.

Workaround:

• You can see the deleted jobs in Report 
Archives.

• To delete jobs that are two days old, specify 
the purge settings as Delete Jobs Older than 
One Day.

Table 3 General Known Problems (continued)

Bug ID Summary Explanation
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Known Problems
CSCsi76700 Multiple Hostname Mismatch 
Java alert windows appear when 
you launch Topology services or 
Path Analysis applications.

This is a bug in Java Webstart. It occurs when you:

1. Run the CiscoWorks Server in the Non SSL 
mode and work with Topology Services or 
Path applications. 

2. Change the mode to SSL.

3. Launch Topology services or Path Analysis

Workaround:

Clear jar cache from java plug in and launch 
Topology services or Path Analysis.

CSCsc24255 Improper error message while 
configuring IVR.

This problem occurs in the following scenario:

If you do not enter proper SNMP or Telnet 
credentials for a device in DCR, RME does not 
fetch Config details from that device. 

When you try to configure IVR for that device in 
Campus Manager, the following error message 
appears:

Configuration failed. Archive does not 
exist.

Workaround:

• Enter proper SNMP and Telnet credentials for 
the device in DCR.

• Make sure that the device is managed by RME 
and Config archive details are available.

CSCsb28190 Campus Manager applications 
do not start in ACS mode.

Topology Services, Path Analysis, VLAN Port 
Assignment, and Discrepancy Report tasks do not 
start when you login to CiscoWorks in ACS mode. 

This problem occurs if you select Assign a 
Ciscoworks on a per Network Device Group 
Basis in ACS server, but in the selected device 
group, you do not add the CiscoWorks server IP 
address.

Workaround:

When you assign a user to a specific group, ensure 
that you also add the device group that contains 
the CiscoWorks server.

For example, assume that the user is added to 
group X and Cisco Works belongs to device group 
Y, add the device group Y also to group X.

Table 3 General Known Problems (continued)

Bug ID Summary Explanation
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Known Problems
CSCsa44629 Campus Manager does not 
restore Topology Map settings 
after you take a back up and 
restore the data on another 
machine, that has Campus 
Manager 4.0.

Campus Manager does not save the changes to 
layout style and background colors in Topology 
Map settings, that were backed up in another 
machine.

This occurs when you:

1. Modify Topology Map settings on a machine 
with Campus Manager 3.3.

2. Back up and restore the files on another 
machine, which has Campus Manager 4.0.

3. Run Data Collection.

4. Start Topology Services.

Workaround:

1. Run 
NMSROOT/campus/conf/upgrade/cm/topo/
2cm31maplayout.pl on the machine with 
Campus Manager 3.3 to generate the map 
files.

2. Copy the map files to the location on the target 
system, where you have restored the data: 
NMSROOT/campus/etc/users/username/

3. Upgrade Topology Map by selecting 
File > Upgrade View Layouts from Topology 
Services.

CSCsa22708 Campus Manager does not 
manage existing devices when 
you upgrade from higher device 
limit to lower device limit.

This problem occurs because Campus Manager 
performs a fresh discovery of the network to 
obtain the devices and does not import them from 
the earlier versions.

Workaround:

None.

CSCdu51651 You cannot select the first 
template from the drop-down 
box, when you create 
SPVC/SPVP/Advanced 
parameters.

Under ATM if you create SPVC/SPVP/Advanced 
parameters, you cannot select the first template 
from the drop-down box. This is because the 
traffic parameter fields are not populated.

Workarounds:

1. Go to Select/Edit and select the template.

2. Click OK.

Or

1. Select the second template

2. Select the first template.

Table 3 General Known Problems (continued)

Bug ID Summary Explanation
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Known Problems
CSCdt22462 Download of Java applets on 
Windows 2000 machines may 
take longer than expected if virus 
checker application is enabled.

On some Windows systems, the initial download 
of large Java applets (or subsequent downloads of 
the same applets that are not cached locally) might 
take longer than expected (up to six minutes in 
some instances). 

After the applet has been loaded and cached 
locally, the problem no longer occurs.

The delay is caused by client side filtering 
mechanisms such as virus scanning. Some virus 
scanners are configured to automatically scan 
content downloaded by browsers. 

Scanning consumes a lot of memory and results in 
disk paging on most systems.

Hence, downloading is significantly slower than 
expected. The effect is less on systems with large 
amounts of RAM and virtual memory.

Workaround:

Disable the automatic scanning of all downloaded 
files, and instead enable the scanning of program 
files only (specified by file extension).

Exact instructions vary depending on the virus 
scanner installed on your system.

CSCds88388 Cannot launch CiscoView on an 
IGX series device.

This occurs if you:

1. Launch Topology Services.

2. Open LAN Edge view.

3. Right-click on IGX series device and select 
CiscoView from the Context menu.

A dialog box appears. 

4. Enter appropriate community strings, and 
CiscoView attempts to launch. 

An error message appears.

Workaround:

Launch CiscoView on IGX series devices via 
Cisco WAN Manager.

CSCdm83204 Campus Manager applications 
do not work when you access 
CiscoWorks using 
http://localhost:1741

If you access CiscoWorks applications using 
http://localhost:1741 from a browser on the 
same machine that CiscoWorks server is installed 
on, Campus Manager suite of applications will not 
work.

Workaround:

Use full DNS name or IP address of server, even 
when accessing it locally.

Table 3 General Known Problems (continued)

Bug ID Summary Explanation
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Browser Known Problems
The table below lists the browser related known problems existing in Campus Manager.

Path Analysis Known Problems
The table below lists the Path Analysis related known problems in Campus Manager.

Table 4 Browser Known Problems

Bug ID Summary Explanation

CSCsi21974 Exporting port attributes report 
crashes the browser.

This occurs if you:

1. Launch port attributes report with more than 
65,000 records.

2. Export the report in PDF format.

The browser crashes after 3 minutes.

Workaround:

None.

CSCin39472 Problems with Campus Manager 
applications after logout.

When you logout from CiscoWorks, 
Campus Manager applications will continue to 
function. However, the following functions will 
not be available:

• Launching Help.

• Tasks in Campus Manager that require user 
action between applications. 

For example, highlighting a device in 
Topology Services using Path Analysis.

Workaround:

1. Close all Campus Manager applications.

2. Login into CiscoWorks.

3. Launch Campus Manager applications.

CSCdp43999 Maps and configuration dialogs 
display offset menus and list 
boxes in Netscape on a Solaris 
client.

Sometimes, when you launch a map or a 
configuration dialog box, menus or list boxes are 
not displayed below the menu. This offset occurs 
in Navigator on a Solaris client.

Workaround:

Move or resize window.
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Table 5 Path Analysis Known Problems

Bug ID Summary Explanation

CSCsa22380 Layer 2 Path Trace is not seen 
between IPv6 End host as source 
and its first hop IPv6 router.

In Path Analysis, when you run a Path Trace using 
IPv6 address of the End host and some other IPv6 
destination (say router), Layer 3 Trace is 
observed. 

However, Layer 2 Trace (switches if any) between 
End host and First hop router is not shown in Path 
Trace.

Workaround:

None.

CSCin37960 VLAN-to-Subnet mapping 
information is not available for 
Phone Traces.

Path Analysis does not provide VLAN-to-Subnet 
mapping information, when you run Path Trace 
between two IP phones.

Workaround:

None.

CSCin37938 Interface Type displays Unknown 
for phones in Path Analysis 
Table.

This problem occurs when you run Path Traces 
between IP Phones or between a device and IP 
Phone.

Workaround:

None.

CSCin36082 Additional hop appears when 
you perform a trace using HSRP 
virtual IP address.

An additional hop appears if you perform a trace 
by providing an HSRP virtual IP address as the 
source or destination in the path trace.

Workaround:

None.

CSCin35773 Map displays self loop when 
routing loop occurs.

Occasionally, when the potential first hop learnt 
by Path Analysis is not discovered successfully by 
Campus Manager, the map displays a self loop.

Workaround:

None.

CSCin30899 Path Analysis does not work 
when LSR Traceroute is 
disabled.

If you disable source route on routers, Path 
Analysis sometimes might not display the route 
occasionally.

Workaround:

None.

CSCin28223 CORBA related error message is 
logged into the log file during 
path trace.

Occasionally, during path trace, a CORBA related 
error message is logged into the ani.log file.

Workaround:

Close the client browser window and relaunch 
Path Analysis.
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Known Problems
CSCin00624 Path trace involving HSRP 
router results in an empty If 
Index entry in the Path Analysis 
table.

This problem occurs when you run a Path trace 
that includes the IP address of an HSRP router in 
the From field of a path trace.

Workaround:

None.

CSCdw15555 Voice trace does not get Cisco 
CallManager cluster information 
if Cisco CallManager HTTPD 
shuts down.

Path Analysis Voice Trace needs to query Call 
Managers known to ANI to check what the cluster 
membership is.

This is done through a HTTP query.

As a security precaution, you might disable the 
Web Server on all cluster members except one. 
This is because Cisco CallManagers use IIS, and 
can be badly damaged by viruses such as Code 
Red and NIMDA.

However, if cluster members have Web Server 
shut off, Path Analysis cannot obtain information 
on cluster membership and cannot retrieve CDRs.

Workaround:

Turn the Web Server on the Cisco CallManager 
back on.

Table 5 Path Analysis Known Problems (continued)

Bug ID Summary Explanation
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CSCdw03410 Path Voice Trace does not 
consider transcoding points.

Current Campus Manager Path Analysis Voice 
Trace is valid only in the case where the two 
endpoints are IP Phones registered with the same 
Cisco CallManager cluster.

For other cases (involving transcoding), Path 
Analysis Voice Trace does not get correct path 
information. 

Examples: 

• Phone call from IP phone to POTS phone off 
H.323 gateway (e.g. 3640) 

• Phone call from one Cisco CallManager 
cluster to another.

In such a case the path would be:

a. From phone 1 to Cisco CallManager 1

b. From Cisco CallManager 1 to Cisco 
CallManager 2 through H.323 
inter-cluster trunk

c. From Cisco CallManager 2 to phone 2

• Phone call to gateway (PSTN, analog, etc.) 

• Phone call to other servers (voicemail, 
conference, etc.)

This is a very complex issue, and may require new 
instrumentation from telephony servers, etc.

Workaround:

None.

CSCdt42600 To and From fields may not 
function properly after selecting 
Print in Path Analysis. 

This problem is caused by Java Virtual Machine 
bug. After you select Print in Path Analysis, the 
To and From fields may not accept mouse focus, or 
focus may appear in both fields, simultaneously. 

Workaround:

Resize the Java console window. If the problem 
persists, close the Path Analysis window and open 
another window. 

Table 5 Path Analysis Known Problems (continued)
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CSCdt42404 Trace tab displays GMT as time 
zone, although server is set to 
local time zone.

A number of Java bugs involve incorrect 
interpretation of time zones. Usually, the correct 
time zone appears if you set the local time zone to 
the appropriate three-letter abbreviation. For 
example, PST for Pacific Standard Time.

This problem is observed on Solaris clients with 
TZ environment variable set to American/Tijuana. 

Workaround:

If the TZ environment variable is instead set to 
PST8PDT, Java interprets local time zone 
correctly.

CSCdt23712 Path Analysis displays the Elvis 
module of Cisco Catalyst 6000 
devices as unknown.

Since Path Analysis depends on ANI for its tracing 
capabilities, if a device-related discovery problem 
occurs in ANI, it results in an unsuccessful trace.

Workaround:

None.

CSCdt04978 Highlighted path trace in 
Topology Services map may be 
difficult to view.

It may be difficult to view highlighted path trace 
in Topology Services map, specially if you select 
the Fit to Window view.

Workaround:

Zoom into Topology Services Map view by 
selecting Select All Highlighted Objects > Zoom 
to Selected.

CSCds79693 Voice trace query results always 
appear using local time zone. 

Local time zone always appears in voice trace 
query results, even if you select GMT time zone 
when specifying call start time. 

Workaround:

None.

CSCds77461 Call Detail Records (CDR) 
query results are sometimes 
displayed after pressing Cancel.

Multiple threads are launched to query every 
Cisco CallManager for information specified in 
your CDR query. 

Since all query activities can take a second or two 
to cancel, query results sometimes continue to 
appear even after you press Cancel.

Workaround:

None.

Table 5 Path Analysis Known Problems (continued)
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User Tracking Known Problems
Information displayed in a row might not reflect the most current network state. This is because User 
Tracking discovery takes information from routers and switches. 

Since these switches collect their information at different times, the information in a row reflects the 
state of the network or subnet at the time displayed in the Last Seen field.

The table below lists other User Tracking related known problems in Campus Manager.

CSCds77438 Path Analysis Map tab does not 
refresh properly.

This problem occurs when running both the client 
and the server on the same machine. It occurs after 
running a large number of Path traces on the client 
browser.

Workaround:

Close browser and relaunch Campus Manager.

We recommend that you run the client and server 
on different machines. 

Although this does not prevent this problem, it 
reduces its frequency because you need to run a 
large number of traces before the problem occurs.

Table 5 Path Analysis Known Problems (continued)

Bug ID Summary Explanation
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Table 6 User Tracking Known Problems

Bug ID Summary Explanation

CSCse03980 User Tracking Custom Report 
does not work properly for User 
Defined Groups.

This occurs in the following scenarios:

Scenario 1:

1. Select the User Defined Groups checkbox, 
with no User Defined Groups under it.

2. Create Custom Report.

Report is generated for all the devices managed in 
Campus Manager. This is the case with Immediate 
Reports as well as Scheduled Jobs.

Scenario 2:

1. Create an User Defined Group.

2. Create a custom report for that User Defined 
Group.

3. Delete that User Defined Group.

4. Launch End host Immediate report using the 
above custom report. 

Report launches for devices that were a part of 
the deleted User Defined Group. 

The scheduled job for the above report completes 
successfully. However, the report does not display 
any records.

Scenario 3:

1. Create an User Defined group with a query 
that results in zero devices.

2. Create a custom report for that User Defined 
group.

3. Launch End host Immediate report using the 
above custom report. 

Report launches for all devices managed by 
Campus Manager.

The scheduled job for the above report completes 
successfully. However, the report does not display 
any records.

Workaround:

None.
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CSCsg74451 End Host Report should have the 
latest count of Best Practices 
Deviation.

This occurs if you:

1. Launch End host Report.

2. Launch Unacknowledged Best Practices 
Deviations report by clicking the Best 
Practice Deviation count.

3. Select a Best Practice Deviation and click 
Acknowledge.

The selected Best Practice Deviation is removed 
from the report, but the Endhost report still 
displays the old count.

Workaround:

None.

CSCsj17921 Discover End hosts on Trunk 
ports option in User Tracking 
does not work properly, if there 
is only one Trunk port in the 
device.

This occurs if:

• The device has only one end host connected to 
it.

• The end host is connected to the Trunk port in 
the device.

• No end hosts are connected to any other port 
in the device.

Workaround:

1. Assign a port in the device as access port.

2. Assign this access port to the default VLAN.

3. Run Data collection and User Tracking Major 
Acquisition.

The end host connected to the trunk port is 
discovered now.

CSCsh85533 Exporting User Tracking data 
through Data Extraction Engine 
results in Out of Memory error.

When you export 250,000 User Tracking records 
through Data Extraction Engine, it displays an Out 
of Memory error. It is logged in 
NMSROOT/MDC/tomcat/logs/stdout.log.

Workaround:

None.

Table 6 User Tracking Known Problems (continued)

Bug ID Summary Explanation
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CSCsi54994 Launching printer friendly 
format of End host report takes a 
long time.

This occurs when you:

1. Launch Endhost report.

2. Click the Printer option.

3. Enter the range as 1-30000 in printer dialog 
box.

To launch the printer friendly format for 30000 
records, it takes around 15 minutes.

To launch the printer friendly format for History 
reports with 30000 records, it takes around 12 
minutes.

Workaround:

None.

CSCsb17074 User Tracking does not discover 
hosts connected to devices with 
SNMPv3 credentials.

This occurs if:

• You manage the following devices with 
SNMPv3 Credentials

– Cisco Catalyst 2900XL

– Cisco Catalyst 3500XL

– Cisco Catalyst 3750 

– Cisco Catalyst 4000

And

• If there are end hosts connected to these 
devices

Workaround:

• Either manage the devices with SNMPv2 
credentials 

Or

• Upgrade the Operating System in the devices 
to Cisco IOS 12.2(25)SEE.

CSCsc49155 User Tracking report generator 
displays error for some Custom 
queries. 

If you run a custom query on User Tracking 
reports after remote migration, an error message 
appears.

Campus Manager 3.x allows you to create some 
queries that are not supported by CM 4.0.x. Hence, 
an error is displayed when you run the queries.

Workaround:

Delete the old queries created in Campus Manager 
3.x, and create new queries.

Table 6 User Tracking Known Problems (continued)
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CSCsa27118 User Tracking Report displays 
Port State as Static for dot1x 
authenticated ports.

User Tracking Report displays Port State as Static 
when an end host is connected to the switch port, 
that is configured for dot1x authentication.

This is because the device populates vmVlanType 
as Static for dot1x authenticated ports.

Workaround:

None

CSCsa20659 Purge Job is created although 
you delete it from User Tracking 
Report Jobs.

In User Tracking, Purge Job is created even if you 
try to delete it from the User Tracking Report Jobs 
and Common Services JRM pages. 

It gets deleted and then recreated immediately. 
There is no functionality loss because of this.

Workaround:

None.

CSCsa14652 NAM and IDS Modules appear 
as end hosts in User Tracking.

Cisco Catalyst 6000 devices running native IOS 
service modules appear as end hosts in User 
Tracking. 

This is caused by a problem on the device. 

Workaround:

None.

CSCin00363 End host does not appear if 
obsolete device IP address is 
assigned.

If you connect a CDP device to the port and then 
add a new end host, this new end host is not learnt. 
This is because ANI is not aware of such a change. 

Workaround: 

1. Delete the specific device. 

2. Perform Data Collection for the neighboring 
devices. 

3. Perform User Tracking discovery for that 
device. 

CSCin00181 Last Seen field gets updated for 
disconnected IP phones.

The Last Seen field in Phone Tracking 
corresponds only to the Last Seen field on Cisco 
CallManager and not to the Last Seen field on 
Network.

Workaround: 

None.

Table 6 User Tracking Known Problems (continued)
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CSCdw04499 End hosts are not discovered 
with Catalyst 3550 running 
Cisco IOS Release 12.1(6)EA1 
or earlier.

End hosts are not discovered with Catalyst 3550 
XL running Cisco IOS release 12.1(4)EA1 and 
Cisco IOS release 12.1(6)EA1.

Workaround:

This problem has been fixed in Cisco IOS 
release 12.1(6)EA1a. Upgrade to this version.

CSCdw04486 End hosts not discovered with 
Catalyst 2950 running a software 
release earlier than Cisco IOS 
Release 12.0(5)WC2.

End hosts not discovered with Catalyst 2950 
running a software release earlier than Cisco IOS 
Release 12.0(5)WC2.

Workaround:

This problem has been fixed in Cisco IOS 
Release 12.0(5)WC2. Upgrade to this version.

CSCdt25525 User Tracking Main Table 
sometimes displays 
CDP-enabled devices that are 
outside the ANI discovery 
boundary.

During User Tracking discovery, User Tracking 
reads entries from the CAM table. These entries 
may include MAC addresses of devices that fall 
outside the ANI discovery boundary. 

Workaround:

None.

CSCdt06183 User Tracking Main Table may 
not display all entries that are 
displayed in the phone table.

User Tracking entries shown in the Main Table are 
discovered from network. However, User Tracking 
entries shown in the phone table are read from 
Cisco CallManager. 

If User Tracking cannot discover particular 
phones in network, entries for such phones in the 
User Tracking phone table will not have device 
and port information. 

Workaround:

Ensure that the switch to which the IP Phones are 
connected, is managed by Campus Manager.

CSCdr85384 Phone entries displayed by User 
Tracking differ from entries 
displayed by Cisco CallManager.

User Tracking phone entries acquired through 
SNMP for each Cisco CallManager may be 
different from entries in Cisco CallManager.

The Cisco CallManager database displays a 
historical record of all phones registered to Cisco 
CallManager. 

The SNMP agent retains only records of phones 
registered since the agent was started. This 
accounts for any differences.

Workaround:

None.

Table 6 User Tracking Known Problems (continued)
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Topology Services Known Problems
The table below lists the Topology Services related known problems in Campus Manager.

CSCsd58215 DNS resolution for end user 
entries takes inordinate amount 
of  time.

DNS resolution, which occurs for end hosts 
discovered in user tracking, takes a lot of time to 
timeout if the DNS resolution for the 
corresponding IP address is not available in the 
DNS Server.

This is because Campus Manager waits for a 
response from the DNS Server before exiting.

Workaround:

Set the property Ani.resolve=false in 
ANIServer.properties.

CSCse79161 User Tracking does not discover 
endhosts using SNMPv3 if the 
endhosts are connected to some 
of the Catalyst IOS devices such 
as Catalyst 2900, Catalyst 4000 
and Catalyst 6000.

This problem is caused by insufficient support for 
SNMPv3 - VLAN based context names in Catalyst 
IOS devices.

Workaround:

This problem has been fixed in recent Catalyst 
IOS image versions 12.2 and above for some 
devices. So ensure that the devices are running 
these versions of Catalyst IOS.

Also, check whether the image supports 
SNMPv3 - VLAN based indexing for those device 
types. 

If the device does not have support for 
SNMPv3 - VLAN based context names in Catalyst 
IOS, remove SNMPv3 credentials from DCR and 
manage the device using SNMPv2.

Table 6 User Tracking Known Problems (continued)

Bug ID Summary Explanation

Table 7 Topology Services Known Problems

Bug ID Summary Explanation

CSCsh20449 RMON configuration fails in 
Cluster member switches.

When you try to do RMON configuration in a 
Cluster member switch, it fails and displays a 
message SNMP credentials required. 

This happens although the credentials are 
available in DCR.

Workaround:

None.
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CSCsh41208 Topology Services does not 
support deleting 1000 devices at 
a time.

When you try to delete 1000 or more devices at a 
time from Topology maps, nothing happens. 

No error message is displayed. No errors are 
recorded in the ANI log file.

Workaround:

• Delete in batches of 500 devices.

• If you are managing 1000 devices in Campus 
Manager and need to delete all of them, 
reinitialize the database instead of deleting 
the devices from Topology Services.

For details on reinitializing the database, see 
User Guide for Campus Manager 5.0.

CSCsi11610 Background image cannot be set 
if the image name has spaces in 
it.

In Topology views, background image cannot be 
set if the image name contains spaces. 

If you drag the devices in that view, the device 
icons get cluttered.

Example: Hello World.jpg

Workaround:

Set a background image where the image name 
does not have spaces.

CSCse26688 Cannot launch Device Attributes 
report for more than 3000 
devices.

This occurs if you:

1. Select 3000 devices or more from Layer 2 
view in Topology Services.

2. Launch Device Attributes report.

Out of Memory error is displayed in the Java 
Console.

Workaround:

None.

CSCsh18809 Launching Topology Services 
after performing Single Device 
Data Collection, displays errors.

This occurs if you:

1. Make some changes in the device, like 
changing the VTP Domain.

2. Run Data Collection for that device.

3. Close Topology Services and launch it again.

Errors are displayed in the Java Console. This 
issue does not occur consistently.

Workaround:

1. Log out of CiscoWorks and log in again.

2. Launch Topology Services.

It launches without any errors.

Table 7 Topology Services Known Problems (continued)
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CSCsg67273 Changes are not reflected in 
Topology Services after doing 
Single Device Data Collection.

This occurs if you:

1. Launch Topology Services.

2. Select a domain which has only one device in 
it.

3. Use Telnet to connect to that device and 
change the VTP domain to any other name.

4. Perform a single device data collection from 
Topology Services.

5. Collapse the tree view in the left pane of 
Topology Services window.

6. Select View -> Reload from the menu.

7. Select View -> Refresh Summary from the 
menu.

8. Open the VTP view in which the device was 
present.

The view still displays the old VTP domain name.

Workaround:

Close Topology Services and launch it again.

CSCsh71141 N-Hop View Portlet shows 
wrong device icon for MSFC 
Switch.

N-Hop View Portlet shows wrong device icon for 
MSFC Switch if:

• The device is on the edge of the network.

• The device is on the edge of the topology map 
displayed in the N-Hop view portlet

In this case, no options are displayed when you 
select the device. You cannot use Telnet to connect 
to the device or launch other applications.

Workaround:

None.

CSCdr28017 Topology Services does not 
support clusters of devices.

Clusters of devices, that is, sets of devices grouped 
together under the same IP management address, 
are not supported in Topology Services

Workaround:

None.

Table 7 Topology Services Known Problems (continued)
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CSCsa27318 Topology Services displays an 
OutOfMemoryError, while 
working with 3000 devices.

When you save the layouts and re-start topology 
map after using Topology Map tools such as zoom 
and drag, Java console displays an error: 
java.lang.OutOfMemoryError.

Workaround:

1. Go to the Java Plugin Control panel and select 
the Advanced tab.

2. Add Xmx512m to the existing Java Runtime 
Parameters.

CSCsa25203 Campus Manager does not 
generate Time Domain 
Reflectometry (TDR) Report for 
Cisco 3750 and Cisco 4000 
series switches.

Campus Manager displays a blank report when 
you run TDR test on Cisco 3750 and Cisco 4000 
series switches.

This is because MIBs are not available to support 
TDR feature on these devices.

Workaround:

None.

CSCsa22699 Inter-VLAN Routing 
configuration user interface (UI) 
does not differentiate primary 
and secondary IP addresses.

Inter-VLAN Routing configuration user interface 
shows multiple entries for the same interface when 
you configure primary and secondary IP addresses 
for SVI or sub-interfaces.

The UI does not clearly differentiate the primary 
and secondary IP addresses.

Workaround:

This problem does not occur in Cisco IOS Release 
12.1(20)E3 or later.

CSCsa18405 In PVLAN configuration, the 
secondary VLAN creation and 
association to Primary VLAN 
fail on Cisco Catalyst Operating 
System version 8.1.

In devices with Cisco Catalyst Operating System 
version 8.1, Secondary VLAN creation and 
association with Primary VLAN fail if the device 
is running on version VTP version 3.

Workaround:

Either: 

• Upgrade to Cisco Catalyst Operating System 
version 8.2.

Or

• Change VTP version to 2 and VTP mode to 
transparent.

Table 7 Topology Services Known Problems (continued)
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CSCsa12292 VLANs are not loaded for STP 
Offline Computation.

This problem occurs in Topology Services 
when you:

1. Launch STP Offline for PVST From the 
Topology Map.

2. Go to Reports > VLAN STP > 
Recommendations > STP Offline

3. Click Select Instance.

No VLANs are loaded.

Devices that do not support 
CISCO-STP-EXTENSIONS-MIB will not 
support any STP related functionality.

Workaround:

None

CSCsa11888 Channel or Trunk cannot be 
configured because of STP 
recalculation.

Campus Manager sets the channel mode to 
Desirable Non-silent on the selected devices to be 
channelled. However, STP state changes occur 
when any mode change happens.

So, if one of the two devices of the channel is an 
end-device and is only reachable through the 
to-be-channelled links, the device cannot be 
reached until the spanning-tree converges.

Workaround:

None.

CSCsa10216 Incorrect VTP version displayed 
in VTP reports.

This problem occurs in Topology Services:

The VTP Report displays the VTP version as 1 
while the actual VTP version running on the 
device is VTP version 2. 

This problem occurs only with some of the Cisco 
Catalyst platforms such as C4506, C3750G, 
C2900.

Workaround:

None.

CSCsa04026 Link line or connection between 
two devices gets warped, if one 
device is moved.

This problem is seen in Topology services display 
map. 

When there is a long line between devices and you 
drag a device to a different location on the map, a 
kink in the line develops. The link line connecting 
these two devices gets warped. 

The line appears jagged, instead of being straight.

Workaround:

Keep the devices closer to one another.

Table 7 Topology Services Known Problems (continued)
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CSCin68983 Cannot configure Trunk between 
Catalyst 2900XL and Catalyst 
3500XL devices.

Trunk configuration fails between Catalyst 
2900XL and Catalyst 3548XL series switches.

This is caused by lack of MIB support.

Workaround:

None.

CSCin48159 Cannot launch IDSM from 
Service Modules launch point 
for IDSM2 card of Cisco 
Catalyst 6000 device.

From Topology Services, you cannot start IDSM 
using the Service Module launch point. This is 
because of a defect in SNMP agent of the device.

Workaround:

None.

CSCin46641 Campus Manager does not 
calculate Trunk mode related 
discrepancies.

Topology Services does not report the following 
discrepancies for Cisco Catalyst 2900 series, 3500 
series, and 4000 IOS devices, in Trunk mode.

• AutoTrunk

• NoTrunk

• TrunkNegotiationEnabled

This is because of the lack of MIB support in the 
devices.

Workaround:

None.

CSCin46405 Campus Manager does not report 
Spanning Tree discrepancies for 
some devices.

Campus Manager does not report the following 
Spanning Tree discrepancies for some devices:

• BackboneFastDisabled

• UplinkFastDisabled

• BPDUGuarDisabled

• STPEnabledOnAccessPorts

This is because of lack of MIB support in the 
devices.

Workaround:

None.

CSCin46370 Trunk Negotiation Enabled 
Discrepancy Report does not 
show the Trunk mode details of 
the ports of some devices.

TrunkNegotiationEnabled Discrepancy Report 
does not show Trunk mode details of the ports on 
Cisco Catalyst 2950, Cisco Catalyst 3550, and 
Cisco Catalyst 4000 IOS devices. 

This is because of a defect in SNMP agent of the 
device.

Workaround:

None.

Table 7 Topology Services Known Problems (continued)
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CSCin45496 Campus Manager does not report 
UDLD discrepancy for Cisco 
Catalyst 2900 series switches.

Discrepancy Reports does not display UDLD 
disabled discrepancy for Cisco Catalyst 2900 
switches.

This is because of a defect in SNMP agent of the 
device.

Workaround:

None.

CSCin45070 Launch points do not work if 
http/https ports have other than 
the default value.

In Topology Services, the launch points for 
Service Modules function only if the http/https 
port numbers are set to their default value.

Launch Points must function for any valid 
http/https port number configured on the service 
modules.

Workaround:

None.

CSCin43965 Spanning Tree reports more than 
one root for a switch cloud.

Spanning Tree reports more than one root for a 
switch cloud containing Cisco 2900XL, Cisco 
3500XL, Cisco 2950, or Cisco 3550 devices, if the 
selected VLAN is not assigned to any of the ports 
in these devices.

This is because of a defect in SNMP agent of the 
devices.

Workaround:

None.

CSCin36988 Cannot calculate utilization of 
VCs in tunnel.

This problem occurs in Topology Services when 
you:

1. Setup a tunnel between two ATM devices and 
let the devices see each other as Interim Local 
Management Interface (ILMI) neighbors on 
their tunnel interfaces (subinterfaces) only.

2. Select Fabric view.

3. Select a device and its associated VP tunnel 
link.

4. Select Tools > Display VCs > Per device.

5. Click Get Info.

An error appears:

Failed to compute utilization for some 
or all rows

Workaround:

None.
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CSCin36950 Cannot view VCs in a tunnel 
from Topology Services main 
window.

This problem occurs in Topology Services when 
you:

1. Setup a tunnel between two ATM devices and 
let the devices see each other as Interim Local 
Management Interface (ILMI) neighbors on 
their tunnel interfaces (subinterfaces) only.

2. Select Fabric view.

3. Select a device and its associated VP tunnel 
link.

4. Select Tools > ATM Management > Display 
VCs > Per device.

The device or port chooser does not list 
subinterfaces.

Workaround:

None.

CSCin29281 Device Attribute of Cisco 
Catalyst 6000 devices does not 
display the IP address.

Device Attribute of Cisco Catalyst 6000 devices 
does not display the IP address of WS-X6624-FXS 
module.

Instead, Device Attribute displays the IP address 
of Supervisor engine.

This is because of a defect in the SNMP agent on 
the device. For more details, see CSCin33075.

Workaround:

None.

CSCin27895 Topology Services does not 
show VLANs as active, if the 
switch is in NULL folder under 
VTP Domain.

Topology Services > VTP Domains > NULL 
folder shows VLANs in VTP server devices as 
inactive, if the VTP Domain name is not 
configured on the device.

Topology Services displays the VLANs as inactive 
although the state of the VLAN on the switch is 
active.

Workaround:

Either: 

• Configure VTP domain name in the device 
and rediscover.

Or

• Configure VTP domain mode of the device as 
transparent and rediscover.
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CSCin22459 Topology Groups membership 
update does not work as 
expected.

This problem occurs in Topology Services when 
you:

1. Launch Custom Views for a group by 
selecting Campus Manager > Topology 
Services.

2. With the Custom Views window open, delete 
a device group using Topology Group 
Administration.

Custom View does not update automatically.

Workaround:

Re-open the Custom View window.

CSCin01977 Position of devices connected to 
Switch Cloud change after 
upgrade.

Switch clouds and fabrics represent the collection 
of LAN switches and ATM switches, respectively.

These logical entities are very specific to the 
currently discovered network. That is, if a new 
switch is discovered, you cannot uniquely identify 
a switch cloud or fabric across ANI databases.

Workaround:

None.

CSCef67937 Campus Manager does not show 
port as trunking if the port is part 
of the Channel.

This problem occurs when Cisco Catalyst 3750 
has a 12.1 EA software version.

When a port is part of channel and configured as 
trunk, Campus Manager does not display the port 
as trunking for Cisco Catalyst 3750 switches.

Workaround:

Upgrade Cisco Catalyst 3750 device to 
12.2(18)SE1 or later.

CSCeb68819 Topology Services does not 
display dual links.

When two devices with dual links are aligned 
vertically on top of each other, the co-ordinates of 
the vertices of both links become the same. 

If the devices are not vertical, Topology Map 
displays dual links. 

Workaround:

Relayout the maps using hierarchical or 
symmetrical layout, so that the devices do not 
align vertically.
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CSCea39271 Topology Services displays the 
devices connected to a UB 
Token-Ring Hub in the 
Unconnected Devices View.

CiscoWorks discovers Cisco Catalyst 4700 and 
Catalyst 4500 devices, but displays them under 
Unconnected Devices View, and not in Layer 2 
View.

Campus Manager cannot draw the map for the 
devices, as the routers are connected through a UB 
hub.

Workaround:

None.

CSCdw49136 Campus Manager cannot 
establish connection between 
ATM ELAN and Ethernet VLAN 
when you remove LEC from 
Cisco Catalyst 2900XL devices.

Initially, VLAN and ELAN are connected in 
Topology Services. When you remove LEC from 
Cisco Catalyst 2900XL devices, the connection 
between VLAN and ELAN is broken for 2900XL 
devices.

This is because of a bug on 2900XL agent devices, 
where it does not support CISCO-LEC-EXT MIB.

Workaround:

None

CSCdv41860 Fetching LANE component 
details displays an error 
AniSQLException.

In Topology Services, if you create a LANE 
component in an ATM switch (LS1010) and 
launch its view, all the Profile and Diagnosis menu 
items related to this component display the 
following error:

Internal error

Workaround:

None.

CSCdt50619 Two devices, connected by 
multiple links, appear to be 
connected by only one link.

When two devices are connected by multiple links, 
and you rediscover either devices or links, all of 
the links are stacked on one another. 

This causes the devices to appear as if they are 
connected by only one link.

Workaround:

Perform a re-layout.

CSCdt27824 Entire list of ports in a VTP 
domain appear when you select 
certain Transparent VTP 
domains from the VLAN 
Assignment dialog box.

When similar VLAN definitions exist on a VTP 
server and transparent devices, VLAN is added 
under the parent folder and all transparent devices.

Thus, VLAN ports appear under all transparent 
devices.

Workaround:

Run Find Ports query and enter only device 
name/address to view ports for a particular device.

Table 7 Topology Services Known Problems (continued)
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ANI Server Known Problems
The table below lists the ANI Server related known problems in Campus Manager.

CSCdt18293 Visio drawing does not import 
cleanly into Microsoft Visio.

If you export a Topology map as a Visio drawing, 
it is not imported cleanly into Microsoft Visio.

Links are drawn out of place, and some incorrect 
links appear to be drawn between devices.

Workaround: 

Clean the Visio drawing manually after import.

CSCdr11577 Virtual Circuit (VC) error chart 
is blank.

A blank chart could mean either a continuous 
polling failure or a failure caused by other 
problems. 

For example, a blank VC error chart might be 
caused by a continuous polling failure (of VC 
error related data). 

It could also be because these statistics may not be 
supported on certain image versions of the ATM 
switch, being polled.

Workaround:

None.

CSCdp88318 Link attributes are not updated 
after a change is made.

If you change link attributes, ANI Server does not 
properly discover and display the change in 
reports. 

Workaround:

To update link attributes, close and relaunch 
Topology Services.

Table 7 Topology Services Known Problems (continued)
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Table 8 ANI Server Known Problems

Bug ID Summary Explanation

CSCsf24921 Campus Manager does not 
load the 
DeviceDiscovery.properties 
file.

This occurs if you:

• Repeatedly change Device Discovery settings 

• Upgrade from a previous version of Campus 
Manager

It corrupts the DeviceDiscovery.properties file. 
After this, you cannot start Device Discovery and it 
remains in idle state.

Workaround: 

1. Delete the corrupted file.

2. Rename NMSROOT/campus/etc/cwsi/
DeviceDiscovery.properties.orig file 

to

NMSROOT/campus/etc/cwsi/
DeviceDiscovery.properties 

3. Use Campus Manager UI to re-enter the 
parameters.

CSCsi34231 Cannot start Device Discovery 
or Data Collection, after 
upgrading from earlier version 
of LMS to LMS 3.0.

This occurs if you:

1. Install LMS 2.5.1 + Service Packs + LMS 2.6 + 
Service Packs.

2. Populate data and upgrade to LMS3.0.

3. If there is a space crunch in the server, reboot the 
server.

After that, Device Discovery or Data Collection 
cannot be started from the Campus Manager home 
page. 

It displays the error Cannot connect to ANI Server 
since it is down, although ANIServer is up.

However, you can run Device Discovery from 
Campus Manager Admin page. 

If you run pdshow ANIServer command from the 
CLI, it displays Auto Generated Reply instead of 
ANIServer started.

Workaround:

Restarting ANIServer will solve the issue.

CSCsi56555 PVLAN is not created after 
ANI server restart.

After restarting ANIServer, you cannot create 
PVLANs.

Workaround:

After restarting ANIServer, run Data Collection. 
After completion of Data Collection, configure 
PVLAN.
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CSCsc43106 Device not discovered if 
SysUpTime is masked.

If the SysUpTime is masked in v1default view, 
Device Discovery does not discover the device.

Workaround:

• Manually add the devices to DCR.

Or

• Remove the mask in v1 default view.

CSCsa20827 Subnet based groups are not 
deleted from Campus Manager 
Topology Groups although 
you delete them from DCR.

In DCR, if you delete all devices or all devices in a 
subnet, the corresponding subnet based groups in 
Campus Manager are not deleted immediately.

Workaround:

If you want the subnet groups to be deleted earlier 
than 20 minutes, change the property from:

SubnetPollerConfigTime = 1200000 

to a lesser value in the properties file:

NMSROOT/MDC/tomcat/webapps/campus/WEB-I
NF/classes/CM_Implementation_Details.properties.

CSCsa19337 ANI goes into Unknown State 
when you delete all devices 
from DCR.

This problem occurs in ANI when you:

1. Discover some devices by specifying seed 
devices in Campus Manager.

The DCR is updated with those devices.

2. Run data collection on those devices.

3. Invoke Topology Services. 

Devices appear in Views.

Deleting all devices from DCR will show ANI state 
and UT state as Unknown although you specify the 
seed devices in Device Discovery settings.

Workaround:

None.

CSCin74855 Device not managed in 
Campus Manager if 
management IP is not in ACS.

If a device has multiple IP addresses, Campus 
Manager automatically determines the management 
IP address of the device. 

If the management IP address is not ACS (that is, the 
device is added in ACS with a different address), this 
device is not managed in Campus Manager. Data 
collection is not done for this device.

Workaround:

IP address in ACS and management IP address in 
DCR should be the same.

Table 8 ANI Server Known Problems (continued)
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CSCin33112 Cannot delete devices on a 
remote system in SSL mode 
using the command line 
interface.

The Delete Device command fails if you use it on 
a remote server in the SSL mode.

Workaround:

None.

CSCdz11668 ANI Discovery causes 
interfaces to go down.

If you install Campus Manager on Solaris 2.8, the 
database interfaces go down shortly after beginning 
discovery. 

This causes the browsers to stop communicating 
with the CiscoWorks server. The interfaces while 
being displayed as UP in ifconfig, do not appear 
when you enter netstat -rn.

This problem is caused by a Solaris bug; Sun Alert 
ID: 48601: Solaris 8 and Solaris 9 Network Interface 
may Stop Responding to TCP Traffic.

This problem occurs in the following releases:

• Solaris 8 with patch 108528-16, or

• Solaris 8 with patch 108528-17 but without 
patch 113652-01

Workaround:

• Downgrade to kernel patch 108528-15 or earlier 
and restart the system.

Or

• Disable the ANIServer process allows 
CiscoWorks to continue functioning without 
Campus Manager applications.

The Sun bug mentioned above is resolved in Solaris 
8 with patch 108528-17 and patch 113652-01 (for 
use with patch 108528-17 only).

Table 8 ANI Server Known Problems (continued)
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CSCdw67129 Topology Services cannot 
resolve the hostname of newly 
discovered devices.

If you add the DNS entry for the devices after initial 
discovery, Topology Services cannot resolve the 
hostname of the newly discovered devices. 

The subsequent discoveries do not resolve the IP 
address to a hostname until the ANIServer reloads.

This occurs only in devices that do not have a DNS 
entry before discovery. Devices that have a DNS 
entry before ANI discovers them, do not have this 
problem.

Workaround:

Do either of the following: 

• Restart CiscoWorks Server. ANI resolves the 
IP address to a hostname after restart.

Or

1. Display the sysName in Topology Services 
(does not require a restart). 

2. Select Topology Services  > Layer 2 View > 
View > Display Labels > Show Sysname

Alternatively, you can do any of the following:

• Run Device Discovery again.

• Stop and start the ANIServer.

• If you require Campus Manager to ignore the 
cache and always look up the DNS server, add 
the following variable in the Java command line 
of the ANIServer:

Dnetworkaddress.cache.ttl=0

CSCdt20329 ATM switches, for which 
Remote Monitoring (RMON) 
is enabled, are not highlighted 
when Show Enabled Devices 
is selected.

This problem occurs when you:

1. Select Topology Services.

2. Highlight an ATM fabric under Managed 
Domains/ATM Domains

3. Select Display View.

4. Select devices, and click Tools > RMON Data 
Collection > Show Enabled Devices

Workaround:

None.

CSCdp76410 Campus Manager client 
cannot connect to server using 
proxies.

Campus Manager does not support proxies.

Workaround:

None

Table 8 ANI Server Known Problems (continued)
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VLAN Configuration Known Problems
The table below lists the VLAN Configuration related known problems in Campus Manager.

CSCdm58624 Campus Manager reports VTP 
Disconnected Domain 
discrepancy when VTP 
Domain is configured across a 
LANE Trunk.

Campus Manager reports Disconnected Domain 
discrepancy even when VTP domain is configured 
across ATM cloud and the default ATM-VLAN is 
configured to carry VTP advertisements across the 
cloud.

Workaround:

Ignore the discrepancy.

CSCdm48015 An ATM trunk port is shown 
as belonging to a VLAN, even 
if there is no corresponding 
LANE client associated with 
that VLAN.

In VLAN-to-port association, all ATM ports on 
switches (except ATM switches) belonging to 
VLAN appear.

Workaround:

Ignore ATM ports in VLAN-to-port association.

CSCdp00593 SNMP report displays wrong 
HwVersion and 
HwVersionMinor for Cisco 
LS1010 devices.

This is because the image has reached EOE.

Workaround:

Enter show hardware in the command line interface 
of Cisco LS1010 devices.

CSCdm91634 In Campus Manager device 
report, number of ports in a 
device’s ATM module are 
incorrectly displayed as zero.

This problem occurs in Catalyst 5000 devices 
running Catalyst operating system software 
release 4.3(1a). It is caused by missing if Entry for 
device ATM module. 

ANI Server depends on ifEntry to determine number 
of ports in a particular module.

Workaround:

None.
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Table 9 VLAN Configuration Known Problems

Bug ID Summary Explanation

CSCsi30755 Ports are not listed properly 
when shared VLANs are 
deleted.

This problem occurs in this condition:

Assume that a VLAN is present in the all the 
transparent devices in the VTP domain (shared 
VLAN).

If you:

1. Go to the VLAN Configuration page

2. Select a shared VLAN from VTP server and 
delete it.

3. Navigate to the Move affected ports to new 
VLAN page:

Along with the ports associated with the VTP 
server is shown, the ports associated with Client 
and the Transparent switches in the domain are 
also listed.

You can move the ports of the deleted shared VLAN 
only to other shared VLANs.

Workaround:

None.

CSCsi85533 Wrong error message 
displayed when you try to 
create VLANs in VTPv3 
server.

VLAN creation on VTPv3 servers are not supported. 
When you try to do this, Campus Manager displays 
the following error message:

There has occurred some error during configuration. 
The device may be snmp unreacheable.Pls check the 
device.

/var/adm/CSCOpx/log/ani.log records the following 
error: 

SNMP illegal value is set.

Workaround:

None.
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Spanning Tree Protocol Known Problems
The table below lists the Spanning Tree Protocol related known problems in Campus Manager.

CSCsc24275 VLAN interfaces created 
through IVR are not shown in 
the existing interface list for 
that device.

If the corresponding VLAN on which the new 
VLAN interface is being created does not already 
exist in the device, the interface is not shown in the 
list.

Workaround:

• Create a VLAN in the device before you create 
VLAN interfaces.

Or 

• Create interfaces for existing VLANs in the 
device.

CSCdw09818 Port Attribute in VLAN Port 
Assignment displays incorrect 
information.

This problem is observed only on inactive ports. The 
MIB values returned by the devices latch on to the 
previous speed and duplex properties.

This is because of a defect in SNMP agent of the 
device. 

Workaround: 

None.

Table 9 VLAN Configuration Known Problems (continued)
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Table 10 Spanning Tree Protocol Known Problems

Bug ID Summary Explanation

CSCsg92439 Campus Manager does not 
compute the correct number of 
instances, when there are 
redundant links between 
switches. 

This occurs if you:

1. Configure redundant links between switches.

2. Invoke MISTP or MST recommendations for a 
switch cloud that has redundant links.

3. Choose Max Instances for better link 
utilization and click Compute.

Campus Manager does not compute the correct 
number of instances for better link utilization.

However, the above computation works well when 
Ether channel is configured on switches with 
redundant links.

Workaround:

None.

CSCsa12292 VLANs not loaded for STP 
Offline Computation.

This problem occurs in STP when you:

1. Launch STP Offline for PVST From the 
Topology Map.

2. Go to Reports >VLAN STP 
Recommendations > STP Offline

3. Click Select Instance

No VLANs are loaded.

Devices that do not support 
CISCO-STP-EXTENSIONS-MIB will not support 
any STP related functionality.

Workaround:

None.

CSCsa09287 Cannot map VLANs to 
instance if the device runs 
MISTP.

In STP, if the device is running STP type as MIST, 
configuring the instance to VLAN mapping from 
STPConfiguationReport > InstanceTab is not 
applied on the device. 

This is caused by an SNMP Agent problem.

Workaround:

None.
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Resolved Problems in Campus Manager 5.0
The following table lists the problems that have been fixed in Campus Manager 5.0.

CSCin67279 Community suffix support is 
not available for MST on 
Cisco IOS switches.

In STP, community suffix support is not available for 
MST and MISTP on Cisco IOS switches.

Workaround:

None.

CSCed72194 MST device report does not 
report CIST root correctly.

In STP, MST device report may not report the CIST 
root properly.

This is because the dot1dStpDesignatedRootCost 
object corresponds to external root path cost. Hence 
the value of the object is 0 for all switches in the 
MST region that contains the CIST root.

Workaround:

None.

Table 10 Spanning Tree Protocol Known Problems (continued)

Bug ID Summary Explanation

Table 11 Resolved Problems in Campus Manager 5.0

Bug ID Summary Additional Information

CSCsa83185 Campus Manager did not support 
backup and restore of User Tracking 
data.

This problem has been resolved.

CSCsa83204 Migration from Campus Manager 3.3 
to Campus Manager 4.0 did not retain 
User T racking data.

This problem has been resolved.

CSCsb16402 Campus Manager did not support 
running discrepancy reports as 
scheduled jobs.

This problem has been resolved.

CSCsb22576 Campus Manager did not support Port 
Utilization Report which lists the ratio 
between number of connected ports and 
the total number of ports.

This problem has been resolved.

CSCsc34746 User Tracking Duplicate reports 
displayed large number incorrect 
entries, when the network had mobile 
users.

This problem has been resolved.

CSCsc43340 Campus Manager did not support 
sorting based on subnets in End host 
report.

This problem has been resolved.
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CSCsc67741 User Tracking Acquisition page took a 
long time to load, even though the 
ANIServer process was running 
normally.

This problem has been resolved.

CSCsc97040 ANI database password was not 
displayed to the user during typical 
installation.

This problem has been resolved.

To see the password, click the Yes option in 
the installation screen.

CSCsd66335 Topology maps did not display links in 
the following scenario:

Switches that have IP address with a 
subnet mask of 31 or 32 and are 
connected via point-to-point link.

This problem has been resolved.

CSCse97191 Neighbors column in Device Discovery 
report got truncated, if the device had 
too many neighbors.

This problem has been resolved.

CSCsf16486 End host report supported string sort 
for the following columns:

• VLAN ID

• Port

• Port speed

However, when you export the reports, 
number sort was supported for exported 
reports.

This problem has been resolved.

The following is supported in End host 
report now:

• Custom sort for Port column

• Number sort for VLAN ID column

• String sort for Port speed column

The above is supported for exported reports 
also.

CSCsf21018 User Tracking did not discover End 
hosts that are not ICMP reachable.

When an End host has multiple IP 
addresses for the same MAC address, 
then User Tracking discovered only the 
IP addresses that were ICMP reachable.

This problem has been resolved.

CSCsg01956 Campus Manager reported BPDU guard 
disabled on access ports 

discrepancies if:

• Catalyst 2950 series switches had 
BPDU Guard and BPDU Filter 
features enabled globally but not 
explicitly configured on per-port 
basis 

and

• Port Fast feature enabled on per 
port basis

This problem has been resolved.

Table 11 Resolved Problems in Campus Manager 5.0 (continued)

Bug ID Summary Additional Information
44
Release Notes for Campus Manager 5.0 on Solaris

OL-12202-01



 

Resolved Problems in Campus Manager 5.0
CSCsg28657 You could not edit an existing schedule 
or add a new one to UT Major 
Acquisition.

This problem has been resolved.

CSCsg45903 UTDebug command did not perform 
debugging operations, if Encrypt 
Community Strings property is enabled 
for Device Discovery.

This problem has been resolved.

CSCsg66351 When there were a lot of completed 
report jobs in Campus Manager, 
launching the home page hung and 
displayed a blank page.

This problem has been resolved.

CSCsg70320 While assigning ports to VLANs:

• If you selected multiple ports to 
assign to a specific VLAN 

And 

• Selected the option to save the 
running-configuration to 
startup-configuration 

Only the first selected port was saved to 
the startup-configuration.

This problem has been resolved.

CSCsh12120 If you:

• Deleted a device from DCR

And

• Added a new device (of a different 
device family) with the IP address 
of the deleted device

The new device was not displayed in 
Topology maps and was not properly 
managed in Campus Manager.

This problem has been resolved.

CSCsh46715 End host reports did not contain host 
name and IP address information, if the 
connected switch and the associated 
router were in different VTP domains.

This problem has been resolved.

For the end host reports to have all 
information, 

set the property 
UTExcludeDomainMatch = true 

in

NMSROOT/campus/etc/cwsi/ut.properties

CSCsh87332 The help for SNMP settings in Device 
Discovery did not explain the timeout 
and retry settings properly.

This problem has been resolved.

CSCsh99080 User Tracking cmexport command 
throws Out of memory error while 
exporting 63,000 records.

This problem has been resolved.
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Obtaining Documentation, Obtaining Support, and Security 
Guidelines

For information on obtaining documentation, obtaining support, providing documentation feedback, 
security guidelines, and also recommended aliases and general Cisco documents, see the monthly 
What’s New in Cisco Product Documentation, which also lists all new and revised Cisco technical 
documentation, at:

http://www.cisco.com/en/US/docs/general/whatsnew/whatsnew.html

CSCsf21023 When an End host had multiple IP 
addresses for the same MAC address, 
User Tracking did not delete inactive IP 
addresses until all IP addresses became 
inactive.

This problem has been resolved.

CSCsg60187 Campus Manager Port Attributes report 
did not display the correct duplex state, 
for the ports on ATM devices

This problem has been resolved.

CSCsh67850 Device Discovery got into an infinite 
loop if:

• Resolve by Sysname option was 
enabled in discovery settings

And

• IP address of the device was 
present in the exclude filter list

This problem has been resolved.

CSCsi34246 Path Analysis did not trace the full 
Layer 2 path for L2L3 switches.

This problem has been resolved.

CSCsi42738 Subnet based User Tracking 
Acquisition did not detect end hosts 
associated with VLANs present in 
transparent mode devices.

This problem has been resolved.

CSCsi65585 User Tracking reports did not support 
multiple email addresses while 
scheduling reports.

This problem has been resolved.

Table 11 Resolved Problems in Campus Manager 5.0 (continued)
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Open Source License Acknowledgements
The following acknowledgements pertain to this software license.

OpenSSL/Open SSL Project
This product includes software developed by the OpenSSL Project for use in the OpenSSL Toolkit 
(http://www.openssl.org/).

This product includes cryptographic software written by Eric Young (eay@cryptsoft.com).

This product includes software written by Tim Hudson (tjh@cryptsoft.com).

License Issues

The OpenSSL toolkit stays under a dual license, i.e. both the conditions of the OpenSSL License and the 
original SSLeay license apply to the toolkit. See below for the actual license texts. Actually both licenses 
are BSD-style Open Source licenses. In case of any license issues related to OpenSSL please contact 
openssl-core@openssl.org.

OpenSSL License:

© 1998-1999 The OpenSSL Project. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided 
that the following conditions are met:

1. Redistributions of source code must retain the copyright notice, this list of conditions and the 
following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions, and 
the following disclaimer in the documentation and/or other materials provided with the distribution.

3. All advertising materials mentioning features or use of this software must display the following 
acknowledgment: “This product includes software developed by the OpenSSL Project for use in the 
OpenSSL Toolkit. (http://www.openssl.org/)”

4. The names “OpenSSL Toolkit” and “OpenSSL Project” must not be used to endorse or promote 
products derived from this software without prior written permission. For written permission, please 
contact openssl-core@openssl.org.

5. Products derived from this software may not be called “OpenSSL” nor may “OpenSSL” appear in 
their names without prior written permission of the OpenSSL Project.

6. Redistributions of any form whatsoever must retain the following acknowledgment:

“This product includes software developed by the OpenSSL Project for use in the OpenSSL Toolkit 
(http://www.openssl.org/)”

THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT “AS IS”' AND ANY EXPRESSED OR 
IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES 
OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN 
NO EVENT SHALL THE OpenSSL PROJECT OR ITS CONTRIBUTORS BE LIABLE FOR ANY 
DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES 
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR 
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER 
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT 
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LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY 
OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGE.

This product includes cryptographic software written by Eric Young (eay@cryptsoft.com). This product 
includes software written by Tim Hudson (tjh@cryptsoft.com).

Original SSLeay License:

© 1995-1998 Eric Young (eay@cryptsoft.com). All rights reserved.

This package is an SSL implementation written by Eric Young (eay@cryptsoft.com).

The implementation was written so as to conform with Netscapes SSL.

This library is free for commercial and non-commercial use as long as the following conditions are 
adhered to. The following conditions apply to all code found in this distribution, be it the RC4, RSA, 
lhash, DES, etc., code; not just the SSL code. The SSL documentation included with this distribution is 
covered by the same copyright terms except that the holder is Tim Hudson (tjh@cryptsoft.com).

Copyright remains Eric Young’s, and as such any Copyright notices in the code are not to be removed. 
If this package is used in a product, Eric Young should be given attribution as the author of the parts of 
the library used. This can be in the form of a textual message at program startup or in documentation 
(online or textual) provided with the package.

Redistribution and use in source and binary forms, with or without modification, are permitted provided 
that the following conditions are met:

1. Redistributions of source code must retain the copyright notice, this list of conditions and the 
following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and 
the following disclaimer in the documentation and/or other materials provided with the distribution.

3. All advertising materials mentioning features or use of this software must display the following 
acknowledgement:

“This product includes cryptographic software written by Eric Young (eay@cryptsoft.com)”.

The word ‘cryptographic’ can be left out if the routines from the library being used are not 
cryptography-related.

4. If you include any Windows specific code (or a derivative thereof) from the apps directory 
(application code) you must include an acknowledgement: “This product includes software written 
by Tim Hudson (tjh@cryptsoft.com)”.

THIS SOFTWARE IS PROVIDED BY ERIC YOUNG “AS IS” AND ANY EXPRESS OR IMPLIED 
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO 
EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, 
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT 
NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, 
DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY 
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT 
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF 
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

The license and distribution terms for any publicly available version or derivative of this code cannot be 
changed. i.e. this code cannot simply be copied and put under another distribution license [including the 
GNU Public License].
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Any Internet Protocol (IP) addresses used in this document are not intended to be actual addresses. Any examples, command display output, and 
figures included in the document are shown for illustrative purposes only. Any use of actual IP addresses in illustrative content is unintentional and 
coincidental.
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